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Introduction 

All documents that are made publicly available (printed or electronic) are required to meet the 

accessibility requirements set out in the Accessibility for Ontarians with Disabilities Act (AODA). 

Specifically, all final documents shall comply with the accessibility standards set out in Guidance on 

Applying WCAG 2.0 to Non-Web Information and Communications Technologies (WCAG2ICT). 

https://www.w3.org/TR/wcag2ict/  

This guideline is intended to assist LSRCA in reaching accessibility compliance and incorporates 

accessibility best practices.  

There are many elements of accessibility that need to be considered with creating documents.  

Elements of accessibility include:  

• Text 

• Contrast and Colour 

• Spacing 

• Design and Formatting 

• Document Structure and Headings 

• Alt Text or Text Descriptions of Non-Text Content 

• Columns and Tables 

• Reading Order 

• Simplicity and Plain Language 

• Links 

Refer to the Accessible Document Guidelines for Web and eDocuments for additional requirements 

specifically for electronic documents.  

Refer to Appendix A for a checklist and quick reference of the requirements outlined in this Guide.   

https://www.w3.org/TR/wcag2ict/
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Guidelines 

To produce accessible formats of documents for persons with disabilities, please adhere to the following 

guidelines. 

Text 

Font  

Font legibility is essential especially for persons with visual disabilities.  

Do’s  

• Use clear font (i.e. Calibri) with easily recognizable characters for documents, printed 

publications, minutes and agendas.  

• Font style should be less ornate (i.e. sans serif fonts)   

• Font style should be consistent throughout the document, wherever possible.  

• Use fonts with medium heaviness.  

• Characters should be distinct, not too thick or too thin  

• Use black type on white background or white print on dark background.  

• Restrict coloured text to titles, headings or highlighted material.  

Don’ts  

• Do not use decorative style fonts  

• Do not use stylized fonts  

• DO NOT CAPITALIZE ALL WORDS OR PHRASES throughout documents.  

• Do not use light type with thin strokes  

Bold Italics and Underline  

Use bold fonts for emphasis to make certain words and phrases stand out from surrounding text. Use 

restraint to ensure only the most important information has emphasis. Use bold formatting for titles, 

headlines or key words and phrases. 

Italic fonts are more difficult to read than regular fonts. There may be exceptions to using italics, such as 

when required to meet standard formatting (e.g. citation in legal).  

Underlining interferes with lower case letters. Do not use underlining to emphasize words and phrases. 

Only use underlining as the standard option to emphasize links for email addresses and websites. 
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Large Print 

Documents are considered to be large print if the font size ranges from 16-48 point text or higher. The 

scale varies according to the visual disabilities of individuals.  LSRCA Guidelines for Large Print is: Calibri 

18.  

Alignment  

Left alignment is recommended for all paragraph text because the start of each sentence is consistent, 

which makes it easier to read.  

• Left align all paragraph text 

• Do not centre text as it can be difficult to find the start of the sentence using magnification 

devices 

• Do not align text to the right because it makes it difficult to find the start of the sentence  

• Do not justify text because it produces gaps between words on a line, posing a challenge for 

persons using magnification device 

Contrast and Colour 

It is essential to create documents with high contrast between text colour and background, especially 

for persons using screen readers or suffering from dyslexia. Achieving a suitable colour palette that will 

work for everyone is difficult, so the following guidelines should serve as a benchmark to achieve at 

least 70% contrast. 

Tips for Achieving High Colour Contrast  

• Use high contrast colours for text and background. For example, black and white or dark blue 

text on a white background or white text on a black or dark blue background 

• Emphasize the lightness of light colours and darkness of dark colours, when used next to each 

other, to enhance contrast 

• Do not use colours which are similar in lightness or darkness next to each other. For example, 

light green and light red may not be easy to distinguish  

• Do not use similar colours together. For example, red, orange and green together will be a little 

difficult to distinguish  

• Do not use achromatic colours (black, white, grey) against colours of similar lightness or 

darkness. For example, dark grey against black  

• Do not use text on an image or patterned background as letters and shapes will be harder to 

identify 

Good Colour Combinations to Help Achieve 70% Colour Contrast  
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• Light colours against black background.  

• Dark colours against white background.  

• Light or pale colours against very dark colours background. For example, light pink or yellow 

against dark blue  

• Black text on a solid background.  

Poor Colour Combinations  

• Pairing red and green together because it is difficult to distinguish the two.  

• Using dark colours against black background.  

• Pairing pastel colours together or against grey or white.  

• Pairing light or pale colours together.  

• Using jarring complimentary colours like orange and blue together. 

Spacing 

Letter Spacing  

This refers to the spacing between letters   Make sure the space between letters is wide enough, so the 

letters and words are easily recognizable. Most accessible typefaces have adequate spacing by default.  

Margins  

Make margins wide enough with sufficient space for binding, hole-punching etc.  A line of text should be 

no wider than 6” to 6.5” across an 8.5” size page.  

Leading  

This refers to the space between lines of text. It is recommended to use the “format” and “paragraph” 

functions to set the “before” and “after line spacing” at “auto” and set the “line spacing” at single or 

1.15 point size. 

Paragraph Spacing 

Do not use enter, space or tab keys to add white space. 

Properly add space before or after content. 

Customize the amount of space before or after content with the Paragraph Spacing tool or set default 

spacing with the Styles tool. 

Use a single space between punctuations. 
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Use the Page Break tool to start a new page. Do not press Enter repeatedly to start a new page.  

Use the Columns tool in the Layout tab. Do not use blank spaces and tabs to create a column effect.  

The MS Word Show/Hide paragraph marks tool in the Home tab will help you find any blank spaces in a 

document. 

Repeated blank characters can confuse a screen reader. If you press the Enter key two or more times, a 

screen reader may interpret the “enter” as a new paragraph with no text. A screen reader may 

communicate the word “blank” for every blank line. 

Design and Formatting 

The accessibility, usability, legibility, ease of reading and comprehension of a document largely depends 

on its design and formatting. Documents should be designed and formatted in a manner that is clear, 

easy to read and understandable.  

The key to clear design is simplicity. Essentially, less is more. Too much colour, shapes and design is 

distracting, especially for persons with visual disabilities.  

• Use distinctive colour, sizes and shapes on the cover page of flyers, brochures, presentation 

documents and reports to make them easier to tell apart from the rest of the document. 

• Avoid watermarks or complicated background designs. 

Document Structure and Headings 

Headings are a powerful tool in creating accessible documents. Headings provide structure and allow 

readers to easily navigate a document by directing readers to the content or paragraph it references. 

This is particularly important when readers are using adaptive technologies (e.g. screen reader) to 

navigate a document. Headings can be created in Word, PDF and HTML and make it easier for all users 

to find relevant content in a long or complex document.   

• Headings should be clear and distinct.  

• Headings should be hierarchical; A level 1 heading should always come before a level 2 heading 

• Place headings close to the paragraph it references, so they remain associated.  

• Keep headings with corresponding paragraphs left aligned.  

Other strategies can also be used to give a document structure including: 

• Ordered (or numbered) and unordered (bulleted lists) 

• Proper tables with a brief summary and row and column headers. 
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• Ensuring that columns, text boxes, asides, and other content are created using a method that 

allows for proper reading order of the document to be maintained when it is read with an 

assistive device.   

Alt Text or Text Descriptions of Non-Text Content 

Images, graphs, charts, or text boxes can be used in a document to convey meaning, ideas or add a 

creative touch for sighted people. These non-text elements can also facilitate the ease of 

comprehension, for people suffering from dyslexia or visual learners. All non-text content must be given 

alternative (alt) text. When using non-text elements, be mindful of the following guidelines.  

• Use non-text elements only if it conveys a meaning or adds relevance to the document.  

• Elements that are intended to be decorative don’t have to be removed, but they must be 

identified as decorative. 

• Always include alt text that describes the element for persons using assistive devices 

• For charts and graphs, ensure that a title as well as alt text is included   

• Do not overlay text on images, wherever possible. 

• To ensure the accessibility of non-text elements, the “wrapping style” should be set as “In line 

with text”. 

When entering alt text you will notice there is a Title and Description field. The Title field is used to enter 

text that when read to someone using a screen reader, it allows the user to decide whether to listen to 

the text provided by the Description. However, it is generally recommended that the main Alt text 

should be put into the Description field. 

1. Select the image and right click inside the image. A menu will appear. 

2. Select Format Picture. 

3. In the Format Picture window, select the Size and Properties tab on the right and select ALT 

TEXT 

4. Then insert the ALT Text into the Description field, NOT the Title field. 

Not all Alt text is created equally. To ensure that alt text is written adequately, be mindful of the 

following:  

• Consider the content and function of your image. 

• If it provides content to your document, make sure that the information the image provides is 

described in the alt text. Descriptions should be brief, about 125 characters.   

• If your image only provides a function (for example, providing a portrait of a historical figure 

described in the text) you need only describe the image. In the case that the image is of a 

historical figure, write his/her name as the alt text. 
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• If a document is created correctly, screen readers are able to identify if an element is text, 

image, chart, graphic, etc. There is no need to identify the element as an image, chart, graphic, 

etc. in the alt text. 

• Do not repeat the information which is contained in the document itself into the alt text (i.e. If 

it's already in the document, that should be enough) 

Columns and Tables 

Columns and tables can create challenges for persons using assistive devices. If it is necessary to use 

columns in a document, ensure the following guidelines are followed:   

• To make columns, use the column function to create standard column width and spacing.  

• Keep corresponding sentences and paragraphs together within columns, wherever possible.  

• Use clearly labelled column and table headings that describe the numerical or written content 

• Format numbers in clear, standard and consistent format (e.g. always use the same decimal 

count, currency notation, and abbreviations such as ‘thousands’ 

• Tables should include a Heading Row. If a table is longer than a page, Heading Rows must be 

repeated at the top of the table on each of the following pages. 

• Keep tables and charts simple (e.g. do not merge cells or manipulate other table elements) 

Reading Order 

Most accessibility checkers do not have capability to ensure that the reading order is correct. Assessing 

Reading Order requires a manual check. The reading order of a document determines how a document 

will be navigated through by an assistive device. Appropriate navigation through a document is 

important to the overall meaning of the document. Using appropriate headings will help to improve the 

logical reading order. When assessing reading order, be mindful of the following guidelines:  

• In Microsoft Word, the reading order of your document will follow the paragraph and heading 

structure embedded in the document 

• Tables in Microsoft Word by default will read top to bottom, left to right. To understand the 

reading order, click on the top left cell and ‘tab’ through the table. This may not be in the order 

you might have intended 

• In PowerPoint, slide elements read bottom to top by default. This can be manipulated by 

rearranging the order through the ‘Selection’ Pane   

• In PDF documents, ensure that the document is appropriately tagged in the correct order  
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Plain Language (Readability) 

When creating a document, consider incorporating some of the basic principles of plain language or 

plain English. The goal is always to use language in a way that is user friendly, clear, direct and natural. 

When creating a document, always consider who the target audience is. Make it your goal to convey the 

ideas with the greatest possible clarity.  

Writing in Plain Language may prove to be challenging, especially in the development of formal or 

technical reports. Always assess whether information can be conveyed in a simplified way, or if there is 

a need to include technical language in your document.  

Here are some tips in creating a plain language document:  

• Use simple, direct words. Omit needless words. 

• Avoid technical jargon. 

• Avoid using acronyms. If you do use them, spell them out in the first instance. 

• Be consistent with the terms you use to mean the same thing. 

• Try to use short and medium-length sentences with an average length of about 20 words. 

• Try and keep paragraphs under 10 or 12 lines. 

• Use Active voice. 

• Use examples or analogies to make complex information more understandable. 

• User parallel structure for parallel ideas. State related ideas in similar grammatical form. 

• Don’t use unnecessary qualifiers, multiple negatives. 

• Avoid redundancies. 

• Consider the structure of your sentences. For example 

o instead of ‘We made an application’ use ‘We applied’. 

o instead of ‘In order to’ use ‘to’. 

o instead of ‘not able’ use ‘unable’. 

Links 

Screen reader users often scan or search for hyperlinks, so it is important to make sure these links make 

sense without their surrounding content. Links are more accessible when the link text briefly describes 

the destination. Avoid non-descriptive link phrases such as “here”, “click here”, “read more” or “learn 

more”. 

Documents with the potential to be printed should include the full URL in a footnote, appendix or in 

brackets after the live link. The standard visual representation for a link is: 
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• Underlined text. 

• Blue for a link not visited (HEX #0000FF, RGB 0-0-255). 

• Purple for a visited link (HEX #800080, RGB 128-0-128). 

Unconvertible Documents 

There are challenges to making documents accessible, considering there are times when information 

and communication is not technically feasible to convert, or if the technology to convert is not readily 

available. Documents may be considered unconvertible if the information may be lost in the conversion 

process and cannot be conveyed in a meaningful way (e.g. a map showing land elevation) 

If you believe that information is considered unconvertible, ensure that there is written explanation as 

to why the information is unconvertible, and ensure that there is a summary of the unconvertible 

information. This information should be available to any person who requests the information.  
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Accessible Document Checklist – Advanced Accessibility 

Text 

☐ Use Calibri in 12 point 

☐ Use the same font throughout the document 

☐ Only use Bold, Italics, and Underline if necessary 

☐ Ensure text is left aligned 

Contract and Colour 

☐ Ensure at least 70% contrast with text and backgrounds 

☐ Check colour combination of graphics to ensure adequate contrast 

Spacing 

☐ Ensure adequate letter spacing 

☐ Review margins. Ensure there is enough space around the document 

☐ Ensure there is adequate spaces between lines of text. Set line spacing to ‘single’ or ‘1.15 point size’ 

☐ Check for blank characters and paragraphs (use the show/hide paragraph marks tool) 

☐ Ensure page breaks are used when starting a new page 

Design and Formatting 

☐ Simplify the format as best possible 

Heading 

☐ Use the title style for your title page. Do not use Heading 1 

☐ For the table of contents heading, use the TOC Heading style 

☐ Use Heading 1 as top-level heading such as chapter or section titles and go forward one level at a 

time (i.e. move from Heading 1 to Heading 2, to Heading 3, etc.)  
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Non-Text Content 

☐ Set wrapping style of non-text elements as “In line with text” 

☐ Add alternative text to graphics and images 

☐ Avoid text boxes, Word Art, and background images as they may be inaccessible to screen readers 

☐ Include titles or captions to graphs or charts 

☐ Remove non-text elements that do not have a function or mark them as ‘decorative’, so they aren’t 

picked up by an assistive device 

Columns 

☐ To properly insert a column use Page Layout tab then Columns 

☐ Avoid using spaces and tabs, it will not be recognized as a column by assistive technology 

Tables 

☐ Use the Insert tab then Table to properly insert 

☐ Use proper Table Headings and check the Header Row check box 

☐ If a table is longer than a page; Heading Rows must be repeated at the top of the table on each of the 

following pages 

☐ Ensure tables are not merged 

Reading Order 

☐ Perform a manual check of the reading order 

Plain Language 

☐ Review the document for plain language 

☐ Review if technical jargon is necessary and revise the document 
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